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System Requirements 
Before installing Database Oasis, you should verify that your computer meets the recommended system 
requirements. 

Operating System 
Database Oasis is compatible with Windows operating systems including Windows XP and later. 
You must have the latest service packs available from Microsoft® installed on your computer. 

RAM 
You will need a minimum of 256MB of RAM to operate Database Oasis. It is recommended that 
you have 512MB of RAM. 

Screen Resolution 
Your screen resolution must be set to at least 800x600. Setting your resolution to 1024x768 or 
greater is recommended. 

Hard Drive Space 
The Database Oasis application will initially require 30 MB to install. You will need additional hard 
drive space as you use the software and add data. You are able to store up to 4TB (Terabytes) of data 
in Database Oasis. 
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Installation 
There are three different types of Database Oasis installations: 

• Basic Edition is a single-user product that is installed and used on one computer. 

• Professional Edition is a multi-user product. The database is installed on one computer on the 
network, then accessed by other computers over the network. This primary installation is called 
the server. 

• Professional Edition clients are installed on each machine that needs to use Database Oasis. They 
are exactly like the server, except that the database isn’t installed locally. Instead, they access the 
database located on the server. 

If you will be using Database Oasis - Basic Edition, you will simply need to install the software on the 
computer you will be using to work with your data. 

If you will be using Database Oasis - Professional Edition, you will need to select where you want to 
install the server. 

Selecting where to Install the Professional Server 

   This feature is only applicable to Database Oasis Professional Edition. 

If you will be using Database Oasis - Professional Edition, chances are you will need to access the 
software from more than one computer. In this case, you need to decide which computer will host 
the data. When choosing where to install the data server, keep the following points in mind: 

• The computer where the data resides will need to be accessible on your network to all of the 
computers that will be using Database Oasis. 

• The computer where the data resides will need to be turned on and logged into Windows 
when other people want to use the software. 

Once you’ve decided where to install the server, you can perform the client installation on any other 
computers that will need to access Database Oasis. 

Hint 

 If you do not want the data on the same computer as 
Database Oasis, you can move it to another location 
after installation. 
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Installing Prerequisites 
Database Oasis requires version 4 of the Microsoft .NET Framework from Microsoft© Technologies 
and version 3.1 or later of the Windows Installer. These applications are typically included with the 
Windows operating system, but older Windows installations may have earlier versions of these 
applications.  

The Database Oasis installer checks your system for these prerequisites on launch. If the required 
versions are not installed, the Prerequisites Wizard will launch to walk you through the installation. 

INSTALLING PREREQUISITES  

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 

2 Launch the DBOasisSetup.exe file that you downloaded.  

3 If Microsoft .NET Framework 4.0 and Windows 3.1 are not already installed on your 
computer, the Prerequisites Wizard will appear: 
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4 Click Next to access a list of the missing prerequisites.  

 

5 Click Next to begin installation of the prerequisites. If the .NET Framework is the 
only missing prerequisite, skip to step 9. If you do not have Windows Installer 
version 3.1 or later installed, the Software Update Installation Wizard for the installer 
will launch: 
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Note 

 As part of the Windows Installer you will be required 
to reboot your computer. Make sure all other 
applications are closed before proceeding. 

6 Click Next to begin the installation. The Software Update Installation Wizard will ask 
you to accept the end user license agreement, then launch the installation process. 
When it is complete, you will be promoted to restart your computer.  

7 Click Finish to complete the installation and reboot. 

8 When Windows reboots, launch the DBOasisSetup.exe file again to continue with the 
installation. The Prerequisite Wizard will launch to allow you to install the .NET 
Framework. 
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9 Click Next in the Prerequisites Wizard to launch the .NET Framework 4 Setup. 

10 You will be asked to accept the license agreement prior to download and installation: 

 

11 Read and accept the license agreement and click Install. The installation process will 
commence. When it is finished, you will receive a Setup complete screen. 

12 Click Exit to launch the Database Oasis installation process. 



Installation 

Database Oasis Installation Instructions 8

Installing Basic Edition and Professional Edition Server 
The process to install Basic Edition and Professional Edition Server are identical. The edition is 
controlled based on the registration code that is entered after purchasing the software. 

INSTALLING BASIC EDITION AND PROFESSIONAL SERVER  

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 

2 Launch the DBOasisSetup.exe file that you downloaded. The setup files will be 
extracted and the following screen will appear: 
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3 Click Next > to continue. The license agreement screen will open: 

 

Note 

 If a Program Maintenance screen appears instead of 
the License Agreement screen, you already have this 
version of the software installed. 
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4 Please read the license information carefully. If you do not accept the terms of this 
agreement, click Cancel to abort the installation. If you do accept the terms of the 
agreement, select the I Agree radio button and click Next > to continue. The 
Installation Type screen will appear: 

 

5 To install Basic Edition or Professional Edition Server, leave the Standard installation 
radio button selected. 

Note 

 If you have already installed a Professional Edition 
Server on another computer on your network and 
would like to install a client, refer to the Installing 
Professional Edition Clients section, below. 
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6 The Select Installation Folder page will open: 

 

7 This allows you to specify a location for your installation of Database Oasis. It is 
recommended that you install to the default location in the \Program Files folder. If 
you wish to install to a different location, click the Browse… button and select the 
target folder.  

8 Click Next > to continue. The Ready to Install screen will open: 
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9 Click Install to begin installing Database Oasis. A progress screen will appear as the 
software is installed: 

 

10 Once the installation process is complete, the following screen will appear: 

 

11 If you would like to launch Database Oasis, now, leave the Launch Database Oasis 
check box marked and click Finish to exit the wizard.  
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Installing Professional Edition Clients 

   This feature is only applicable to Database Oasis Professional Edition. 

Database Oasis Professional Edition lets users on the same network work together using the same 
database. 

If you want to have more than one person sharing information in Database Oasis, you need to have the 
data stored in a central location on your network that everyone can access. For example, you may have 
three computers that are able to talk to each other over a network.  

Database Oasis needs to be installed on all three computers, but the data only needs to be installed on 
one of them. The other two computers will be told to use the data on that first computer. The computer 
where the data is installed is called the server. The other computers are called clients. 

 

You should run the server installation first to install the data. During the client installation, you will need 
to select the path to the data that was previously installed on the server computer.  
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Configuration for Professional Client Access 
In a network environment, in order for the clients to access the data over the network, you will need 
to set up a network share to the data file. 

CREATING A NETWORK SHARE 

Note 

 There may be slight differences in the procedure for 
sharing data, depending on your operating system and 
security settings. These steps provide an overview of 
common configuration options, but do not cover all 
possible variables.  

 For comprehensive help with configuring a share in 
Windows XP, refer to the article 
http://support.microsoft.com/kb/304040.  

 For help in Windows Vista, refer to the article 
http://www.microsoft.com/technet/network/evaluate/v
ista_fp.mspx.  

 For help in Windows 7, refer to the article 
http://windows.microsoft.com/en-
us/windows7/Share-files-with-someone.  

1 On the computer where Professional Edition is installed, double click on the My 
Computer icon on your desktop: 
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2 The My Computer screen will open: 

 

3 Navigate to the Database Oasis data path. For operating systems prior to Windows 
Vista, the data is located in the path C:\Documents and Settings\All 
Users\Application Data\DBOData. In Windows Vista and Windows 7, the data is 
located in the path C:\ProgramData\DBOData\.  

Note 

 If you do not see the \DBOData folder, it is usually 
because it is hidden in Windows. To unhide the 
folder, right click on your Windows Start button and 
select Explore from the menu to open Windows File 
Explorer. Select Folder Options from the Tools menu, 
then select the View tab. Make sure that the Show 
hidden files and folders option is selected. 
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4 Right click on the \DBOData folder and select Sharing and Security or Share 
(depending on your version of Windows) from the right-click menu: 
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5 The Sharing tab of the Properties screen for the \DBOData folder will open: 

  

Note 

 Depending on your version of Windows, you may 
need to press the Advanced Sharing button on the 
Properties screen to access the sharing options. 

Note 

 If you have never created a network share, this screen 
will have a link to a wizard where you can set up file 
sharing. Follow the on-screen instructions in the 
wizard, if desired. 
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6 Select the Share this folder check box or radio button (depending on your version of 
Windows). This option will make the \DBOData folder accessible to clients on the 
network. 

WARNING! 

 If an outside user is able to access your network, any 
shared folders will be available. Make sure that you 
have security on your network to prevent outside 
access, especially if you are using a wireless network. 

7 Select the Security tab: 

 

Note 

 Depending on your version of Windows, you may 
need to click Edit to open a separate Permissions 
screen to change these settings. 
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8 Verify that there is a group named Everyone in the Group or user names list. If there 
is, skip to step 12. 

WARNING! 

  Selecting the Everyone group gives anyone who is 
able to access your network access to the folder. 
Configuring the Everyone group is the easiest way to 
ensure clients will be able to access the software 
when there is not a security scheme in place. If you 
have group security in place, it is recommended that 
you select groups and/or users that reflect your 
security configuration rather than using Everyone. 

9 If there is no Everyone group, click Add. The Select Users or Groups screen will 
open: 

 

10 In the Enter the object names to select box, type Everyone. 

11 Click OK to save the group and return to the Security tab. 

12 Highlight the Everyone group in the Group or User Names list and select the Full 
Control check box in the Permissions for Administrators box. 

13 Click OK to save the changes and close the Properties screen. 

Testing the Folder Share 
Once you’ve configured your share, it is recommended that you test it outside of Database Oasis by 
trying to access that folder in Windows Explorer from the client computer.  
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TO TEST THE PERMISSIONS: 

1 On the client computer, right click on the Windows Taskbar’s Start button and select 
Explore from the menu. 

2 In the Folders list, select Network or My Network Places (depending on your version 
of Windows). 

3 Navigate to your Database Oasis server computer and make sure you can see the 
Database Oasis data folder in the list.  

Note 

 To navigate to the computer in Windows XP, select 
Entire Network, then Microsoft Windows Network 
under the My Network Places link. 

4 Click on the Database Oasis data folder and make sure you can open it. 

5 With the folder selected, right click in the files section on the right and select New, 
Text Document from the menu and verify it allows you to create a text file in the 
folder. (You may delete the text file if desired.) 

If you are unable to access the folder and create a new file in the folder, clients will not be able to access 
the Database Oasis data. In this case, check the following: 

• On the Database Oasis server computer, verify in Windows that the Guest account is turned on. 
(Refer to Microsoft Windows help for instructions on turning on the Guest account in your 
version of Windows.) 

• Verify that the folder share has been correctly configured using the above instructions.  

Note 

   If you are able to access an existing folder share that is 
working, compare its settings with the new share to 
determine the differences. 

• Depending on the version of Windows and internal security settings, Windows may not allow 
you to grant full access to the default data path. In this case, you may need to move the 
\DBOData folder directly under the C:\ drive. 

Client Installation 
Once you are able to access the data on the server from the other computers on your network, you are 
ready to install the client. 
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RUNNING THE PROFESSIONAL CLIENT INSTALL 

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 

2 Launch the DBOasisSetup.exe file that you downloaded.  

3 Follow the installation steps using the guidelines under Running the Basic Edition 
and Professional Server Install, above. After you accept the license agreement, the 
Installation Type screen will appear: 

 

4 To install a Professional Edition client, select the Client Installation radio button and 
click Next. 

5 The Server Data Path screen will appear: 
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6 Click the Browse button and navigate to the network share containing the Database 
Oasis data file on your Database Oasis server computer. 

7 Click Next to proceed with the installation following steps 6 through 11 under 
Running the Basic Edition and Professional Server Install. The client software will 
install and connect to the data specified in step 6 above. 

(See Clients & Users in Professional Edition in your Database Oasis user manual for help with client 
configuration.) 
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Upgrade Instructions 
Prior to upgrading, please review the following: 

• Before running an upgrade, make sure to back up your existing installation using the Backup 
option on the Tools menu. 

• If you are upgrading Database Oasis - Professional Edition: 

o Make sure all clients are logged off before proceeding.  

o Make sure all clients are upgraded prior to trying to connect to the server.  You will 
not be able to log on from a client that has not been upgraded. 

Note 

 If you upgrade a client before upgrading the server, 
the database will be automatically upgraded when you 
first log on from the client. At that point, you will not 
be able to log on from the server until it has also been 
upgraded. 

• If you are upgrading from a version of Database Oasis prior to version 3.0 

o The version 2.x to version 3.x upgrade requires an upgrade license key. Once you 
upgrade, your installation will become unregistered until you enter an upgrade key. 

WARNING! 

 Be sure to have a backup of your current installation 
before proceeding. When you install version 3.x, 
changes are made to the database that make it 
incompatible with version 2.x. The only way to revert 
to version 2.x once you’ve upgraded is to uninstall 
version 3.x, reinstall version 2.x and restore your pre-
upgrade backup. 

o There is no direct upgrade path to version 3.x from any version prior to version 2.8. If 
you have a prior version, you must first upgrade to version , then to version 3.x. For 
version 2 download files and upgrade instructions, please visit 
http://databaseoasis.com/downloadsv2.aspx.  
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Running the Upgrade 
If you have an older version of Database Oasis and would like to upgrade to a newer version, simply 
run the install as you would for a new installation. Database Oasis will detect your existing 
installation and perform the upgrade. 

UPGRADING DATABASE OASIS  

1 If you have not already done so, download the Database Oasis installation using the 
download link on the www.databaseoasis.com website. 

2 Launch the DBOasisSetup.exe file that you downloaded. The setup files will be 
extracted and the following screen will appear: 
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3 Click Next > to continue. The license agreement screen will open: 

 

Note 

 If a Program Maintenance screen appears instead of 
the License Agreement screen, you already have this 
version of the software installed. 

4 Please read the license information carefully. If you do not accept the terms of this 
agreement, click Cancel to abort the installation. If you do accept the terms of the 
agreement, select the I Agree radio button and click Next > to continue.  
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5 If you are upgrading within the same major version number (for example, from 
version 3.0 to version 3.1), the upgrade will proceed. If you are upgrading from 
version 2.97 or earlier to version 3.x, you will see the following screen: 

 

6 The upgrade from version 2.x to version 3.x requires a license key. If you do not 
already have an upgrade key, make sure you read this page carefully and understand 
that your installation will become unregistered. If that is acceptable, click Install to 
start the upgrade. 
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7 Once the installation process is complete, the following screen will appear: 

 

8 If you are upgrading a Basic Edition or Professional Edition server, the database 
update will be completed when you launch Database Oasis. If you would like to 
launch Database Oasis, now, leave the Launch Database Oasis check box marked and 
click Finish to exit the wizard.  

9 When Database Oasis launches, it will detect that it must upgrade the data and the 
following message will appear: 
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10 Click OK to update your database. Once the data upgrade has completed, the 
following message will appear: 

 

11 Select Enter Registration Key and enter the registration information you were sent 
when you purchased your Version 3.x upgrade key. If you have not yet purchased the 
upgrade key, select Buy Now to be directed to a purchase page, or Cancel to exit 
Database Oasis. 

 


